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  Single-Page Comics 
 
Kreative Komix was designed with students of all ages in mind. We 
wanted to create a product that was useable by beginning writers, yet 
had the power to engage children and adults of all ages. 
 

 

Logging In 
2) The first screen you see is the Kreative Komix log-in. We have the students 

log in so it is easy for them to find their stories. When the stories are saved 
they go into a folder that was created the first time the student logged in. 
This allows us to display only their stories when they click on the Open 
Scene or Book options in the File menu. 

 

 
 
 
 

 
 

3) Once you are logged in and click OK, you are sent to the Main Komix 
screen. 

 
4) Note: Once you have logged in the first time, your name will appear in the 

Select Your Name list. This ensures that your students log in using the 
same name every time. 

Note: After the first time 
you log in, your name will 
appear here. 
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Choosing a Background   
 
The first thing you will usually want to do is choose a background. 
By default, the backgrounds are displayed in the graphic library.  
 

1. First, you need to choose whether you want vertical or horizontal orientation for 
your scene. To do this, click on the Horizontal or Vertical button above the 
background box. If you change your mind later you can always change the 
orientation of a created scene. Note: in Vertical mode you will be able to slide the 
background horizontally to expose different parts of the background. 

 
2. To choose a background, click on the one you would like to use. It immediately 

pops into the story area. 
 
3. To scroll the library to see other backgrounds, click on the blue arrow buttons on 

either side of library. 
 

 
 

4. You can change the background by clicking on any of the other backgrounds. You 
can even do this after you have placed characters and props. The background will 
change, but your characters and props will remain undisturbed. 

Click here 
to get a 
background 
for your 
story. 

Click here 
to scroll the 
library. 
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Adding Characters and Props 
Once you have chosen your background, it is time to add characters and props to 
create your comic. 
 
1. To change the contents of the library, click on the Libraries option on the main 

menu or the Set Menu visible in the tool bar.  
 

 
    Library Menu from the Main Menu bar 
2. Next try clicking on Characters in the Set Menu and then click on one of the fairy 

tales listed in the Parts menu. Now, all the clip art in your library are characters 
for your story. Later, you will learn how to create your own Characters, but first 
click a character you would like to use in your story. 

 
3. The Character you have chosen will pop into your scene with a red box around it. 

This means it is the current Character you are working with.  
 

 

Your 
character 
will pop up 
in the middle 
of the 

Click on the 
character 
you want to 
add it to the 
scene. 

Click here to 
change the 
character set. 
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Now you can move, resize rotate, and flip the character until it’s the way you want it. 
(This is covered in detail in the next section) 
 
 

 
  
 
 
 
8. Now let’s change the Library to props. Add props exactly as you would add 

characters. First, click on the Libraries option on the main menu. Click on Props. 
Now, click on a prop you would like to use and it will pop into the scene. You can 
now move, flip, resize, or rotate it. 

 

Deleting a Character or Prop  
1. Click on the Character or prop you want to get rid of so that it is selected. 
Note: When a character or prop is selected, it will have a red rectangle 
around it. 

 
2. Click on the Trash button at the bottom of the screen and the selected character or 

prop will be deleted along with any animations or sounds associated with it. 
 

Click here 
to resize 
your 
character 
or prop. 

Click here 
to rotate 
your 
Character 
or prop. 

Click here 
to flip your 
character. 

Click here 
to flip your 
character 
or prop. 

Click here to 
delete your 
character 
prop. 

Click here 
to arrange 
your art. 
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Rotating, Scaling, and Arranging Clip art in a Scene 
Once the clip art is in your scene, you are probably going to want to customize it. You 
can move, resize, rotate, or arrange it. All of these commands are available to you in 
two places, the Tools menu item on the main menu bar, and as buttons that run along 
the bottom of the main screen. 
 
To Move Clip art: 
1. Select the piece of clip art you want to move by clicking on it. 
 
2. While still holding the mouse down, drag the piece of clip art to the position you 
want it to be. 
 
To Resize Clip art: 

1. Click on the piece of clip art you want to resize. It will now have a red 
box around it showing that it is selected. 

 
2. Click on one of the Magnifying Lens buttons at the bottom of the screen. 

The Magnifying Lens with the plus sign make it larger, and the 
Magnifying Lens with the minus sign makes it smaller. 

 
3. If you want finer resizing control, you can hold down the Shift key while grabbing 

the red rectangle around the character or prop, and then manually resizing it. 
 
To Rotate Clip art:  

1. Click on the piece of clip art you want to rotate. It will now have a 
red box around it showing that it is selected. 

 
2. Click on one of the Curved Arrow buttons to rotate the clip art. One goes to the 

right and the other goes to the left. 
 
3. If you want finer rotation control, you can hold down the Tab key while grabbing 

the red rectangle around the character or prop, and then manually rotating it.  
 

To Arrange Clip art: 
Because the clip art you add can be on different layers, at times you will need to move 
it in front or back of another piece of clipart. There are four buttons that allow you to 
move the piece of clip art you are working with to the back or front of another 
character or prop. 
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To Move Clip art to the Front:  
1. Select the piece of clip art you want to move to the front. 
 
2. Click on the Front button on the bottom of the screen, and the prop or 

character you have selected will jump to the front. 
 
To Move Clip art to the Back:     

1. Select the piece of clip art you want to move to the back. 
 
2. Click on the Back button on the bottom of the screen, and the prop or 

character you have selected will jump to the back. 
 
Sometimes you will want to move a piece of clip art one layer at a time to fit exactly 
where you want it. You can use the Step buttons to do this. 
 
To Move Clip art One Step Forward at a Time:  

1. Select the piece of clip art you want to move to the front. 
 
2. Click on the Step Forward button at the bottom of the screen, and the 

prop or character you have selected will jump one step to the front. 
 
To Move Clip art One Step Back at a Time:  

1. Select the piece of clip art you want to move to the back. 
 
2. Click on the Step Back button at the bottom of the screen, and the prop or 

character you have selected will jump one step to the back. 
 
Note: You can also use the Arrange menu on the main menu bar to access all these 
commands. 
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Adding Text to Your Komic 
You can add text anywhere in your scene. You can change fonts to add interesting 
effects like creating your own “sound” effects. 
 
To Add Text:  

1. Click on the Text button to enter text mode. 
 
2. Click on the scene in a place where you would like to add text. 
 

Start typing. To format your font, first highlight it, and then use the Style, Font, and 
Size menu items on the main menu bar to change the your font. 
 

 
 
Note: The boxes around the text disappear when you switch out of Text mode.  
You can still type in the created text boxes by double-clicking on them. 
 

You can 
add speech 
bubbles for 
your text. 

You can 
even add 
computer-
generated 
speech. 
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Using Speech Bubbles 
What would a comic book be without speech bubbles? In this program, speech 
bubbles are actually graphics that you find in the Libraries menu on the Main Menu 
bar. While the speech bubbles and text box are separate objects it’s easy to combine 
them to look exactly like the ones you see in comic books. 
 
1. First, select the Speech Bubbles library in the Libraries menu on the Main Menu 

bar. The available speech bubbles will appear in the library on the right hand side 
of the screen. 

 
2. Next, select the speech bubble you want to use by clicking on it in the library. It 

will appear in the middle of the screen with a red box around it showing that it is 
selected. 

 
3. Now you can resize it to fit your text box and then move the speech bubble under 

the text. Note: You can adjust the either the size of the text box or speech bubble in 
Text or Scene mode by using the + or – magnifying glasses in the bottom tool bar. 

 
Using Computer-Generated Speech 
If you don’t want to take the time to record speech for your text (covered in the 
following section), you can add computer-generated speech while in the Text. This is 
easy and fun to do. 
 
To Make a Text Box Speak: 
1. When you enter the Text mode, you will notice the top menu bar changes. The 

second row of buttons now has speech controls. 
 

 
 

2. To activate computerized speech for a text box, first select the text box, and then 
click on box to the right of the Use in Player button. This tells all the text on the in 
the box to speak when the scene is run in the Player. The next section will tell you 
how to create different voices for each of your characters. 
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Controlling the Voice of the Computerized Speech 
You can choose from a variety of voices that are built-in to Kreative Komix. This is a 
great tool for adding personality to your characters. 
 
1.  Click on the rectangle to the right of the Speak Text button and a 

list of built-in voices appears. 
 
2.  Choose one to use for the text box you have selected.  
 
3.  You can always test the voice by choosing it, and then clicking on 

the Speak Text button.  
 
Note: To control the order in which your text is spoken, go to 
Sequence and change the order of the numbers that appear next to the 
text boxes, characters and props. (See the section Sequencing your 
actions and sounds on pg.21)
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Adding Sounds to Your Komic 
Kreative Komix is a truly multimedia program. What could be more fun than creating 
comics that talk and have sound effects? We’re sure that you will enjoy making the 
sounds as much as you enjoy adding them to your comics. You can make different 
characters, use different voices, or make your own outrageous sound effects that 
happen as your characters and props animate. 
 
Recording Sounds  

1. First, click on the Sound button at the left-hand side of the 
program. 

 
2. Now, click on the object you would like to have associated with 

that sound. As soon as you let go, the Sound Tools will appear in the Tools bar. 
To make your characters talk, click on the speech bubble for the character you 
want to speak. You can also click on any character or prop and attach a sound to it. 

 

 
 
3. You can now record your sound by clicking on the Record button in the Sound 

toolbar. Note: Of course. you will need a microphone for you computer to do this. 
Next, you will be asked to name your sound. Once you name the sound and click 
on the OK button, you start recording. To stop recording click on the Stop button. 

Click on 
the Record 
button to 
start 
recording. 

Click here 
to use the 
built-in 
sounds or 
the ones 
you have 
previously 
created.


